


ค าน า 
 
การพฒันาแอปพลเิคชนัฝัง่เซริฟ์เวอร ์(Backend) ในปัจจบุนัมคีวามซบัซอ้นและหลากหลายมากขึน้เรื่อย 
ๆ นักพฒันาจ าเป็นต้องเขา้ใจทัง้แนวคดิการออกแบบซอฟต์แวรส์มยัใหม่ การจดัการโครงสรา้งโค้ดให้
ง่ายต่อการบ ารุงรกัษา รวมถงึการสรา้งระบบทีส่ามารถขยายตวัไดใ้นอนาคต NestJS จงึเป็นหนึ่งใน
เฟรมเวิร์กที่ตอบโจทย์เหล่านี้ได้อย่างครบถ้วน ด้วยการผสานแนวคิดจาก  Object-Oriented 
Programming (OOP), Functional Programming (FP) และ Dependency Injection (DI) เขา้กบั
ภาษา TypeScript NestJS ช่วยใหน้ักพฒันาสามารถสรา้งแอปพลเิคชนัทีม่คีวามมัน่คง ปลอดภยั และ
รองรบัระบบขนาดใหญ่ได ้

หนังสอืเล่มนี้ “NestJS Web Programming: Beginner” ถูกออกแบบมาเพื่อเป็นคู่มอืส าหรบั
นกัพฒันาทีต่อ้งการเริม่ตน้กบั NestJS ตัง้แต่พืน้ฐานไปจนถงึการสรา้งระบบทีซ่บัซอ้นและเป็นมาตรฐาน
อุตสาหกรรม โดยแต่ละบทจะปพูื้นฐานและต่อยอดอย่างเป็นขัน้ตอน เริม่จากการแนะน า NestJS และ
โครงสรา้งพื้นฐานในบทแรก ซึ่งครอบคลุมตัง้แต่แนวคดิ ความเป็นมาของ NestJS ขอ้แตกต่างจาก 
Framework และ Library ยอดนิยมบน Node.js ไปจนถงึการตดิตัง้ Nest CLI การสรา้งโปรเจกต์ใหม ่
และการทดสอบโปรเจกตบ์น IDE/Editor ทีห่ลากหลาย 

ต่อมาในบทที ่2 และบทที ่3 ผูอ่้านจะไดเ้รยีนรูก้ารสรา้ง Controller และการจดัการ Routing 
เบือ้งต้น รวมถงึการสรา้ง Service และการน าแนวคดิ Dependency Injection (DI) มาใชเ้พื่อแยก
ตรรกะทางธุรกจิออกจาก Controller การเขา้ใจวธิกีาร inject service เขา้ Controller และการจดัการ 
logic อยา่งเป็นระบบ จะช่วยใหโ้คด้อ่านงา่ย ทดสอบงา่ย และขยายระบบไดโ้ดยไมซ่บัซอ้น 

บทที ่4 จะเน้นไปทีร่ะบบ Modules ของ NestJS ซึง่เป็นกลไกส าคญัในการจดัการโปรเจกต์
ขนาดใหญ่ การสรา้งโมดูลย่อย การ Import และ Export โมดูล ตลอดจนการใช้ Shared Module เพื่อ
รวม logic หรอื Service ทีใ่ชร้่วมกนัหลายโมดูล ท าให้ระบบมคีวามเป็นระเบยีบ ขยายไดง้่าย และลด
การซ ้าซ้อนของโค้ด แนวคดิเรื่องโมดูลยงัช่วยให้การท างานเป็นทมีเป็นไปอย่างมปีระสทิธภิาพ และ
รองรบัการพฒันาระบบทีซ่บัซอ้น 

บทที ่5 จะสอนเรื่อง Data Transfer Objects (DTOs) และ Validation ซึง่เป็นหวัใจส าคญัใน
การจดัการขอ้มลูทีผู่ใ้ชส้่งเขา้มา การใชไ้ลบรารี class-validator และ class-transformer ช่วยให้
สามารถตรวจสอบและแปลงขอ้มูลให้อยู่ในรูปแบบทีถู่กต้อง การสรา้ง DTO พรอ้ม type-check การ
ตรวจสอบ input และการจดัการ Validation Error จะช่วยให ้API มคีวามปลอดภยั ใชง้านไดจ้รงิ และให ้
feedback ทีช่ดัเจนต่อผูใ้ช ้

หนงัสอืเล่มนี้ยงัมตีวัอยา่งบรูณาการและ Ultimate Integrated Project ในแต่ละบท เพื่อใหผู้อ่้าน
ได้ฝึกปฏบิตัิจรงิและเห็นภาพรวมของการพฒันาแอปพลเิคชนั NestJS ตัง้แต่เริม่ต้นจนถึงระบบที่
ซบัซอ้น รวมถงึ Super Ultimate NestJS Project ทีร่วมความรูจ้ากทุกบทใหผู้อ่้านสามารถประยุกต์
สรา้งโปรเจกตจ์รงิไดท้นัท ี



ทา้ยที่สุด หนังสอืเล่มนี้ถูกเขยีนด้วยความตัง้ใจใหผู้้อ่าน เข้าใจแนวคิดเชิงลึก ควบคู่ไปกบั
การปฏิบติัจริง ไมว่่าจะเป็นนักพฒันาทีม่ปีระสบการณ์ Node.js มาก่อนหรอืผูเ้ริม่ต้นทีเ่พิง่รูจ้กั NestJS 
ก็ตาม เราหวงัว่าหนังสอืเล่มนี้จะเป็นคู่มอืที่ช่วยให้คุณพฒันาทกัษะ สร้างระบบที่เป็นมาตรฐาน และ
เขา้ใจแนวทางการออกแบบแอปพลเิคชนัในเชงิมอือาชพี 

 
ดว้ยรกัและปรารถนาด ี
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บทท่ี 1 
แนะน า NestJS และโครงสร้างพืน้ฐาน 

(Introduction to NestJS and Basic Structure) 
 

เน้ือหา  

 แนะน า NestJS และโครงสรา้งพืน้ฐาน 
 ประวตัแิละความเป็นมา 
 ขอ้แตกต่างหลกัของ NestJS เทยีบกบั Framework/Library ยอดนิยมบน Node.js 
 NestJS คอือะไร? 
 แนวคดิ OOP, FP และ DI ใน NestJS  
 โครงสรา้งโฟลเดอรม์าตรฐานของโปรเจกต ์NestJS  
 การตดิตัง้ Nest CLI และการสรา้งโปรเจกตใ์หม ่ 
 การตดิตัง้และทดสอบ NestJS บน IDE/Editor 
 การตดิตัง้ NestJS และทดสอบโปรเจกตบ์น NetBeans IDE  

 
 
บทน าบทท่ี 1: แนะน า NestJS และโครงสร้างพื้นฐาน 
ในยคุทีแ่อปพลเิคชนัฝัง่เซริฟ์เวอรม์คีวามซบัซอ้นมากขึน้เรือ่ย ๆ นกัพฒันาจ าเป็นต้องใชเ้ครื่องมอืทีช่่วย
จดัการโครงสรา้งโคด้ใหช้ดัเจนและรองรบัการขยายในอนาคต NestJS จงึกลายเป็นหนึ่งในเฟรมเวริก์ที่
โดดเด่น เพราะออกแบบมาใหส้อดคลอ้งกบัหลกัการเขยีนโปรแกรมสมยัใหม่ พรอ้มทัง้ใช้ TypeScript 
เป็นภาษาหลกั ท าใหน้กัพฒันาสามารถสรา้งระบบทีป่ลอดภยั มปีระสทิธภิาพ และบ ารงุรกัษาไดง้า่ย 
NestJS คอืเฟรมเวริก์ส าหรบัสรา้ง Server-Side Application โดยท างานบน Node.js และไดร้บัแรง
บนัดาลใจจากสถาปัตยกรรมของ Angular ซึ่งใช้แนวคดิแบบโมดูลาร ์(Modular) และสนับสนุนการ
พฒันาแบบ MVC (Model–View–Controller) และ MV (เช่น MVVM)* ไดอ้ย่างยดืหยุ่น ความสามารถ
เหล่านี้ท าให ้NestJS เป็นทีน่ิยมในการสรา้งแอปพลเิคชนัระดบัองคก์ร เช่น ระบบจดัการผูใ้ช ้ระบบ API 
ขนาดใหญ่ หรอืระบบ Microservices 
หนึ่งในหวัใจส าคญัของ NestJS คอืการน าแนวคดิเชงิสถาปัตยกรรมของ OOP (Object-Oriented 
Programming), FP (Functional Programming) และ DI (Dependency Injection) มาผสมผสาน
เขา้ดว้ยกนั OOP ช่วยใหน้ักพฒันาสามารถแยกความรบัผดิชอบออกจากกนัไดช้ดัเจน FP ช่วยใหก้าร
ประมวลผลขอ้มลูมคีวามยดืหยุ่นและเขยีนโคด้ทีอ่่านง่ายขึน้ และ DI ท าใหก้ารจดัการการพึง่พาระหว่าง
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คลาสต่าง ๆ มีความเป็นอิสระต่อกัน ส่งผลให้โค้ดทดสอบได้ง่ายและสามารถปรบัเปลี่ยนได้อย่าง
คล่องตวั 

เมื่อพูดถงึโครงสรา้งโคด้ NestJS ไดว้าง โครงสร้างโฟลเดอรม์าตรฐาน ทีร่องรบัการท างาน
ระดบัใหญ่ เช่น การแยกโฟลเดอร์ส าหรบั Controller ที่จดัการกบัการรบัส่งค าขอ การแยก Service 
ส าหรบัเกบ็ตรรกะทางธุรกจิ และการใช ้Module เพื่อจดักลุ่มองคป์ระกอบเหล่านี้ใหเ้ป็นเอกเทศ การจดั
โครงสรา้งเช่นน้ีช่วยใหน้กัพฒันาสามารถท างานร่วมกนัเป็นทมีได้อย่างมรีะบบ ลดความสบัสน และช่วย
ใหร้ะบบขยายตวัไดอ้ยา่งมปีระสทิธภิาพ 

นอกจากแนวคดิเชงิสถาปัตยกรรมแลว้ NestJS ยงัมาพรอ้มเครื่องมอือ านวยความสะดวกอย่าง 
Nest CLI (Command Line Interface) ซึง่ช่วยให้การสรา้งโปรเจกต์ใหม่ การเพิม่โมดูล การสรา้ง 
Controller หรอื Service ท าได้อย่างรวดเรว็เพยีงใช้ค าสัง่ไม่กี่บรรทดั Nest CLI ยงัช่วยก าหนด
โครงสรา้งเริม่ต้นของโปรเจกต์ใหอ้ยู่ในรปูแบบมาตรฐาน ท าใหแ้มแ้ต่นักพฒันามอืใหม่ก็สามารถเริม่ต้น
ไดอ้ยา่งถูกตอ้งตัง้แต่แรก 

ในส่วนการปฏบิตั ิบทนี้จะสาธติการ ติดตัง้ Nest CLI และการ สร้างโปรเจกต์ใหม่ โดยเริม่
จากการตดิตัง้ผ่าน npm หรอื yarn จากนัน้จะแสดงวธิกีารใชค้ าสัง่ nest new project-name เพื่อสรา้ง
โครงสรา้งโปรเจกต์อตัโนมตั ิพรอ้มไฟลแ์ละโฟลเดอรท์ีค่รบถ้วน เช่น app.controller.ts, app.service.ts, 
และ app.module.ts สิง่นี้จะช่วยใหคุ้ณไดเ้หน็ภาพรวมของการท างานใน NestJS ไดอ้ยา่งชดัเจน 

กล่าวโดยสรุป บทนี้ไม่เพยีงแต่ท าใหคุ้ณเขา้ใจว่า NestJS คืออะไรและใช้ท าอะไร แต่ยงัช่วย
ปพูืน้ฐานความเขา้ใจเกีย่วกบั แนวคิด OOP, FP และ DI, การจดัโครงสรา้งโฟลเดอรข์องโปรเจกต์ และ
การใช ้Nest CLI เพื่อสรา้งแอปพลเิคชนัแรกของคุณ ความรูเ้หล่านี้จะเป็นรากฐานส าคญัในการต่อยอด
ไปสู่บทถัดไป ซึ่งเราจะได้ลงลึกในเรื่องการสร้าง API และการเชื่อมต่อกับระบบต่าง ๆ อย่างมี
ประสทิธภิาพ 

 
แนะน า NestJS และโครงสร้างพื้นฐาน 

 NestJS คอือะไร? ใชท้ าอะไร? 
 แนวคดิ OOP, FP, และ DI ใน Nest 
 โครงสรา้งโฟลเดอรม์าตรฐานของโปรเจกต์ 
 การตดิตัง้ Nest CLI และสรา้งโปรเจกตใ์หม่ 

บทท่ี 1 — แนะน า NestJS และโครงสร้างพื้นฐาน (ละเอียดแต่เข้าใจง่าย) 
ต่อไปนี้เป็นการอธบิายเชงิลกึแบบเป็นขัน้เป็นตอนส าหรบัหวัขอ้ทีคุ่ณขอ — เหมาะส าหรบัเริม่ต้น
โครงการจรงิและเขา้ใจแนวคดิพืน้ฐานเชงิสถาปัตยกรรม 

 
1) NestJS คืออะไร? ใช้ท าอะไร? 
NestJS คอื ฟราเมิรก์ส าหรบัพฒันา Backend บน Node.js เขยีนดว้ย TypeScript (รองรบั 
JavaScript) ออกแบบมาใหเ้ขยีนโคด้แบบมโีครงสรา้ง เหมาะกบัโปรเจกตข์นาดเลก็ถงึระดบัองคก์ร 
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(enterprise). 
ใช้งานหลกั ไดแ้ก่ 

 สรา้ง REST APIs 
 สรา้ง GraphQL APIs (code-first / schema-first) 
 สรา้ง microservices (gRPC, TCP, NATS, Kafka, RabbitMQ ฯลฯ) 
 WebSocket / real-time apps 
 ใชเ้ป็น backend service ในสถาปัตยกรรมแบบหลายบรกิาร 

เหตผุลท่ีชอบใช้ NestJS 
 โครงสรา้งชดั (Modules / Controllers / Providers) — เหมาะกบัทมีใหญ่ 
 ม ีDependency Injection (DI) ในตวั ท าใหท้ดสอบงา่ย 
 สนบัสนุน patterns ยอดนิยม (CQRS, Clean Architecture, Hexagonal) 
 รวม integration กบั ORM (TypeORM, MikroORM), Prisma, validation, config ฯลฯ 

 
2) แนวคิด OOP, FP, และ DI ใน NestJS (ละเอียด) 
NestJS ผสานแนวคดิ 3 แบบหลกั — OOP (Object-Oriented), FP (Functional Programming), DI 
(Dependency Injection) — เพื่อความยดืหยุ่นและความเป็นระบบ 
OOP (Object-Oriented Programming) 

 Nest ใช ้คลาส เป็นหน่วยหลกั (@Controller(), @Injectable(), @Module() คอื class-
decorators) 

 แนวคดิ OOP ทีเ่ด่น: encapsulation, inheritance, polymorphism 
 ตวัอยา่ง: สรา้ง UsersService เป็น class แลว้ inject ให ้Controller — แยกหน้าที ่(SRP) 

@Injectable() 
export class UsersService { 
  private users: User[] = []; 
  create(userDto: CreateUserDto) { /* ... */ } 
  findAll() { return this.users; } 
} 
FP (Functional Programming) ใน Nest 

 Nest สนบัสนุน FP โดยการใช ้ฟังกช์นับริสทุธ์ิ, การไม่เปลีย่น state, และโดยเฉพาะ RxJS / 
Observables ส าหรบัการจดัการ asynchronous/stream data 

 ตวัอยา่ง: controller หรอื service สามารถคนืค่าเป็น Observable<T> แลว้ pipe operators 
(map, switchMap, catchError) เพื่อจดัการ flow 

 FP pattern ช่วยในการเขยีน logic ทีท่ดสอบงา่ยและ composable 
// ตวัอยา่ง service ทีค่นื Observable 
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import { of } from 'rxjs'; 
import { delay } from 'rxjs/operators'; 
 
getUsers() { 
  return of(this.users).pipe(delay(100)); // เป็น stream ของขอ้มลู 
} 
DI (Dependency Injection) — หวัใจของ Nest 

 Nest ม ีDI container ในตวั — providers (services, repositories, factories) ถูก register ใน 
module และ inject เขา้กบัคลาสทีต่อ้งการผ่าน constructor 

 ขอ้ด:ี แยก concerns, รองรบัการ mock ส าหรบั unit test, ดแูล lifecycle ของ dependencies 
@Controller('users') 
export class UsersController { 
  constructor(private readonly usersService: UsersService) {} // injection ที ่constructor 
} 
รปูแบบ provider ท่ีส าคญั 

 useClass — ใหใ้ชอ้กี class หนึ่ง 
 useValue — ให ้value คงที ่(config, mock) 
 useFactory — สรา้ง provider ดว้ย factory function (รองรบั DI ภายใน factory) 
 useExisting — alias ให ้token เดมิ 

{ 
  provide: 'PAYMENT_SERVICE', 
  useClass: StripePaymentService, 
} 
// หรอื 
{ 
  provide: 'CONFIG', 
  useValue: { host: 'localhost' } 
} 
Scope ของ provider 

 Singleton (default) — instance เดยีวตลอดแอป 
 Request — ใหมทุ่ก request (ใชก้บั request-scoped data) 
 Transient — สรา้งใหมทุ่กครัง้ที ่inject 

@Injectable({ scope: Scope.REQUEST }) 
export class RequestScopedService { /* ... */ } 
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3) โครงสร้างโฟลเดอรม์าตรฐานของโปรเจกต ์(Best practice) 
โครงสรา้งทัว่ไปทีร่กัษา scalability และความชดัเจน: 
project-root/ 
├─ src/ 
│  ├─ main.ts                 # bootstrap app 
│  ├─ app.module.ts 
│  ├─ config/                 # ConfigModule, env schema 
│  ├─ common/                 # filters, guards, interceptors, pipes 
│  │  ├─ filters/ 
│  │  ├─ guards/ 
│  │  ├─ interceptors/ 
│  │  └─ pipes/ 
│  ├─ modules/                # ฟีเจอรเ์ป็น sub-folders 
│  │  ├─ users/ 
│  │  │  ├─ users.module.ts 
│  │  │  ├─ users.controller.ts 
│  │  │  ├─ users.service.ts 
│  │  │  ├─ dto/ 
│  │  │  └─ entities/ 
│  │  └─ auth/ 
│  ├─ shared/                 # shared utilities, constants, types 
│  └─ infrastructure/         # DB adapters, repositories, external API clients 
├─ test/ 
├─ .env 
├─ nest-cli.json 
├─ package.json 
├─ tsconfig.json 
└─ Dockerfile 
ค าอธิบายเพ่ิมเติม 

 src/modules/<feature> — แยกเป็น feature-based modules (Users, Auth, Products) — 
เพิม่ความเป็น modular 

 common/ — เกบ็ cross-cutting concerns (เช่น global exception filter, logging interceptor) 
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 infrastructure/ — adapter ของ DB หรอื third-party (เช่น repository ทีต่ดิ 
TypeORM/Prisma) — ช่วยแยก layer ตาม Hexagonal/Clean Architecture 

 config/ — ใช ้@nestjs/config เพื่อ load .env และ schema validation 
 test/ — unit / e2e tests 

ตวัอย่างไฟลส์ าคญั 
 main.ts — ตัง้ค่า global pipes, global filters, CORS, adapters 
 app.module.ts — root module ที ่import feature modules 
 nest-cli.json — config ของ CLI (sourceRoot ฯลฯ) 

 
4) การติดตัง้ Nest CLI และสร้างโปรเจกต์ใหม่ (ทีละขัน้ตอน พร้อมค าสัง่จริง) 
ม ี2 วธิหีลกั: ตดิตัง้ CLI แบบ global หรอืใช ้npx (ไมต่อ้งตดิตัง้ถาวร) 
ติดตัง้แบบ global (แนะน าถ้าจะใช้บ่อย) 
npm i -g @nestjs/cli 
# หรอื 
yarn global add @nestjs/cli 
จากนัน้สรา้งโปรเจกต์ 
nest new my-nest-app 
# CLI จะถามใหเ้ลอืก package manager: npm / yarn / pnpm 
หรือใช้ npx (ไม่ติดตัง้ถาวร) 
npx @nestjs/cli new my-nest-app 
ค าสัง่ส าคญัหลงัสร้างโปรเจกต์ 
cd my-nest-app 
npm run start          # รนั production build (dist) 
npm run start:dev      # รนั dev แบบ watch (hot reload) 
npm run build          # build -> dist/ 
ใช้ CLI เพ่ือ generate scaffolding (เรว็และเป็นมาตรฐาน) 
nest g module users 
nest g controller users --no-spec 
nest g service users --no-spec 
# หรอื full resource (module+controller+service) 
nest g resource users 
ตวัอย่าง main.ts หลงั scaffold — แนะน าการตัง้ค่าเร่ิมต้น 
// src/main.ts 
import { ValidationPipe } from '@nestjs/common'; 
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import { NestFactory } from '@nestjs/core'; 
import { AppModule } from './app.module'; 
 
async function bootstrap() { 
  const app = await NestFactory.create(AppModule); 
  // global validation และ transform DTO -> class instance ไดอ้ตัโนมตั ิ
  app.useGlobalPipes(new ValidationPipe({ whitelist: true, transform: true })); 
  app.enableCors(); 
  await app.listen(3000); 
} 
bootstrap(); 
ตวัอย่าง package.json scripts (ท่ี CLI ใส่มาให้) 
"scripts": { 
  "start": "nest start", 
  "start:dev": "nest start --watch", 
  "build": "nest build", 
  "format": "prettier --write \"src/**/*.ts\"" 
} 

 
เพ่ิมเติม (tips แบบผู้เช่ียวชาญสัน้ ๆ) 

 เปิดใช ้ValidationPipe และ class-validator เพื่อความปลอดภยัของ input 
(whitelist/transform) 

 ใช ้@nestjs/config ส าหรบัจดัการ .env และตัง้ค่า isGlobal: true เพื่อเรยีกใชท้ัว่แอป 
 แยก feature modules ใหเ้ลก็และชดั — แต่ละ module ควรม ีcontroller/service/dto/entities 

ของตวัเอง 
 ใช ้repository pattern (interface + provider) เพื่อใหง้า่ยต่อการเปลีย่น ORM/DB และงา่ยต่อ

การ mock ใน unit tests 
 เริม่ตน้โครงการดว้ย eslint/prettier และตัง้ CI (lint + tests) ตัง้แต่แรก 

 
ประวติัและความเป็นมา 

 NestJS ถูกเริม่พฒันาโดย Kamil Myśliwiec โดยแรงบนัดาลใจจาก Angular (ในแง ่
architecture, decorators, modularity) เพื่อสรา้ง framework บน Node.js ทีโ่ครงสรา้งชดัและ
รองรบั TypeScript โดยตรง (วกิพิเีดยี) 

https://en.wikipedia.org/wiki/NestJS?utm_source=chatgpt.com
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 เผยแพรค่รัง้แรกในปี 2017 โดยม ีversion ทีแ่ทก็แรกคอื v4.4.0 เมือ่วนัที ่23 พฤศจกิายน 
2017 (วกิพิเีดยี) 

 ปรบัปรงุเรือ่ยมา เพิม่ adapter และ driver ต่าง ๆ เช่น Express เป็น default, ต่อมาเพิม่ 
Fastify เพื่อประสทิธภิาพสงูขึน้ (วกิพิเีดยี) 

 เพิม่ integration กบั message brokers เช่น RabbitMQ, Kafka เพื่อรองรบั architecture แบบ 
distributed / microservices (วกิพิเีดยี) 

 
วิวฒันาการส าคญั / จดุเปล่ียน 

จดุเวลา ส่ิงท่ีเกิดขึ้น 

2017 
NestJS เปิดตวัครัง้แรก — สรา้งบน Express + TypeScript โดยเอาแนวคดิ Angular มา
ปรบัใชใ้นฝัง่ backend (วกิพิเีดยี) 

หลงัปี 2017 
เริม่ม ีfeature เพิม่ เช่น support for Fastify adapter, support for message brokers, 
เพิม่ libraries/modules ต่างๆ (GraphQL, WebSockets, microservices) (วกิพิเีดยี) 

ปัจจบุนั 
(2024–
2025) 

NestJS เขา้สู่ version 10.x/11.x — ม ีmigration guide ส าหรบัการอปัเดต major 
versions เช่น v11 ที ่drop support Node.js เก่า, เน้น performance, security, tooling 
ปรบัปรงุ (NestJS Docs) 

 
สถิติการใช้งาน / ความนิยม 
นี่คอืขอ้มลูทีพ่อมใีห ้ณ ปัจจุบนั (ไมท่ัง้หมด แต่ใหภ้าพรวม): 

 NestJS ม ีGitHub stars จ านวนมาก — อยูใ่นหมวด frameworks/node.js ทีไ่ดร้บัความสนใจ
สงู (วกิพิเีดยี) 

 ใน Latin America, มจี านวน engineer ทีใ่ช ้NestJS มากขึน้: 
o Brazil ~ 6,500 คน (matildaexp.com) 
o Argentina ~ 1,200 คน (matildaexp.com) 
o Colombia ~ 1,100 คน (matildaexp.com) 
o ประเทศอื่น ๆ ใน LATAM กม็กีารเตบิโตสงู เช่น Mexico, Peru, Chile 

(matildaexp.com) 
 การเตบิโตรายปีของ engineers ทีใ่ช ้NestJS ใน LATAM สงู — บางประเทศเพิม่ขึน้เกอืบ 80–

100%+ ต่อปี (matildaexp.com) 
 สถานะล่าสุด: NestJS มเีวอรช์นัล่าสุด เช่น v10.x, และ v11 ทีเ่ริม่มกีารเปลีย่นแปลงส าคญั 

(drop support Node.js เก่า, ปรบัปรงุ features) (NestJS Docs) 

 
ข้อจ ากดัของข้อมลู / ส่ิงท่ียงัไม่ชดั 

https://en.wikipedia.org/wiki/NestJS?utm_source=chatgpt.com
https://en.wikipedia.org/wiki/NestJS?utm_source=chatgpt.com
https://en.wikipedia.org/wiki/NestJS?utm_source=chatgpt.com
https://en.wikipedia.org/wiki/NestJS?utm_source=chatgpt.com
https://en.wikipedia.org/wiki/NestJS?utm_source=chatgpt.com
https://docs-nestjs.netlify.app/migration-guide?utm_source=chatgpt.com
https://en.wikipedia.org/wiki/NestJS?utm_source=chatgpt.com
https://www.matildaexp.com/reports/nestjs-engineers-in-brazil?utm_source=chatgpt.com
https://www.matildaexp.com/reports/nestjs-engineers-in-argentina?utm_source=chatgpt.com
https://www.matildaexp.com/reports/nestjs-engineers-in-colombia?utm_source=chatgpt.com
https://www.matildaexp.com/reports/nestjs-engineers-in-latam?utm_source=chatgpt.com
https://www.matildaexp.com/reports/nestjs-engineers-in-mexico?utm_source=chatgpt.com
https://docs-nestjs.netlify.app/migration-guide?utm_source=chatgpt.com
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 ขอ้มลูสถติบิางอยา่ง เช่น จ านวนผูใ้ชท้ัว่โลก, จ านวนดาวน์โหลด npm ทีแ่ม่นย า, จ านวนบรษิทั
ทีใ่ชจ้รงิ, market share เปรยีบเทยีบกบั framework อื่นๆ ยงัไมม่ขีอ้มลู公開อยา่งครบถว้น
หรอืแมน่ย าเสมอ 

 มากกว่าเน้น region (เช่น Latin America) มากกว่า global ในหลายแหล่ง 

 
ข้อแตกต่างหลกัของ NestJS เทียบกบั Framework/Library ยอดนิยมบน 
Node.js 
ข้อแตกต่างหลกัของ NestJS เทียบกบั Framework/Library ยอดนิยมบน Node.js เช่น 
Express.js, Koa.js, Fastify และ AdonisJS (รวมทัง้เปรยีบเทยีบกบัการเขยีน JS ปกตแิบบ raw 
Node.js) 

 
� ความแตกต่างของ NestJS กบั JS Framework อ่ืน ๆ 

ประเดน็ NestJS Express.js Koa.js Fastify AdonisJS 

โครงสร้าง 
(Architecture) 

ม ีModular Architecture, 
ใช ้Modules / 
Controllers / Providers, 
ชดัเจน เหมาะกบัทมีใหญ่ 

ไมม่ี
โครงสรา้ง
ตายตวั ตอ้ง
จดัการเอง 

Minimal, 
middleware-
driven, 
developer 
ก าหนดเอง 

เน้น 
performance, 
ใช ้schema 
validation 
(JSON 
Schema) 

มโีครงสรา้ง
ใกลเ้คยีง 
Laravel 
(MVC), 
ออกแบบ 
opinionated 

ภาษา 
(Language) 

เน้น TypeScript โดยตรง, 
รองรบั JS 

JS เป็นหลกั
, TS ตอ้ง 
config เอง 

JS/TS, แต่ 
TS 
integration 
ไมด่เีท่า 
Nest 

ม ีTS support 
ด ีแต่ไม ่
opinionated 

TS + JS, ม ี
built-in 
decorators 

แนวคิดหลกั ผสาน OOP + FP + DI 
Callback / 
Middleware 

Middleware-
first 

Schema-
based 
validation 

MVC + 
Dependency 
Injection 

Dependency 
Injection (DI) 

ม ีDI container ในตวั 
(คลา้ย Angular) 

ไมม่ ีตอ้ง
จดัการเอง 

ไมม่ ีตอ้งใช ้
lib เสรมิ 

ม ีbasic DI 
(แต่ไม่
เทยีบเท่า 
Nest) 

ม ีDI แบบ 
built-in 

Scaffolding / ม ีNest CLI, generate ไมม่ ีCLI ไมม่ ีCLI ม ีCLI ม ีCLI 
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ประเดน็ NestJS Express.js Koa.js Fastify AdonisJS 

CLI module/controller/service 
ไดร้วดเรว็ 

(ตอ้งใช ้
generator 
เสรมิ) 

เลก็น้อย ครบถว้น 
(เหมอืน 
Laravel) 

Microservices 
รองรบัหลาย transport 
(gRPC, Kafka, 
RabbitMQ, NATS) 

ตอ้งต่อ lib 
เสรมิ 

ตอ้งต่อ lib 
เสรมิ 

รองรบั
บางส่วน แต่
ไมค่รบ 
ecosystem 

รองรบับาง 
microservices 
แต่ไมย่ดืหยุ่น
เท่า Nest 

GraphQL 
Support 

ม ีintegration โดยตรง 
(schema-first & code-
first) 

ตอ้งใช ้
Apollo/อื่นๆ 
ต่อเอง 

ตอ้งตดิตัง้
เอง 

ตอ้งตดิตัง้เอง 
ม ีGraphQL 
module ใหใ้ช ้

Learning 
Curve 

ชนักว่า Express/Koa 
เพราะตอ้งเขา้ใจ 
Module/DI 

งา่ยมาก 
เหมาะกบั 
beginner 

งา่ย แต่ตอ้ง
ออกแบบเอง
เยอะ 

กลาง ๆ, ถนดั
เรือ่ง 
performance 

ชนัเหมอืน 
Nest เพราะ 
opinionated 

Community / 
Ecosystem 

ใหญ่, เตบิโตเรว็, ใชใ้น
ระดบัองคก์ร (enterprise) 

ใหญ่ทีสุ่ด 
(เป็น base 
ของหลาย 
framework) 

เลก็กว่า 
Express 

ก าลงัโต, ชจูดุ
ขายเรว็ 

Community 
เลก็กว่า 
Nest/Express 

Use Cases ท่ี
เหมาะ 

ระบบใหญ่, ทมีหลายคน, 
Enterprise, 
Microservices, API 
Gateway 

โปรเจกต์
เลก็–กลาง, 
POC, MVP 

โปรเจกต์
เลก็–กลาง, 
custom 
APIs 

APIs ทีเ่น้น 
performance 
สงู 

ระบบ 
fullstack แบบ 
MVC, startup 
apps 

 
� จดุแขง็ของ NestJS เม่ือเทียบกบั JS Framework อ่ืน ๆ 

1. โครงสร้างมาตรฐาน 
o Express/Koa ใหอ้สิระมาก แต่ขาดโครงสรา้ง → โครงการใหญ่จะรก 
o NestJS ม ีmodule system ทีช่ดัเจน เหมาะกบัทมีขนาดใหญ่ 

2. TypeScript-first 
o Express/Koa/JS raw รองรบั TS แบบ optional 
o NestJS ออกแบบโดยคดิถงึ TS ตัง้แต่ตน้ → static typing, DTO, validation ใชง้าน

งา่ย 
3. Dependency Injection (DI) 
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o จดุเด่นที ่Express/Koa ไม่มใีนตวั 
o ช่วยให ้test งา่ย, mock ได,้ ลด coupling 

4. Microservices-ready 
o NestJS รองรบั transport protocol หลากหลาย → RabbitMQ, Kafka, gRPC, 

MQTT 
o Express/Koa ตอ้งใช ้library ภายนอก 

5. เครื่องมือครบใน Ecosystem 
o CLI, config, validation, GraphQL, WebSocket, Microservices, Testing 
o Express/Koa เน้น minimal ตอ้งหามาเสรมิเอง 

6. แนวคิดสถาปัตยกรรมชดัเจน (OOP + FP + DI) 
o เหมาะกบัการน า Clean Architecture / Hexagonal Architecture มาใช ้
o Express/Koa จะยดืหยุ่นกว่า แต่ไมม่ ีframework-level support 

 
� จดุอ่อนของ NestJS 

 Learning curve สงูกว่า Express/Koa → ตอ้งเขา้ใจ module system และ DI 
 Boilerplate code มากกว่าพวก minimal frameworks 
 ถา้โปรเจกตเ์ลก็มาก (เช่น API งา่ย ๆ ไมก่ี ่route) อาจจะ “หนกัเกนิไป” 

 
� สรปุสัน้: 

 ถา้โปรเจกตเ์ลก็/ตอ้งการเรว็ → Express/Koa 
 ถา้เน้น performance สงู → Fastify 
 ถา้อยากได ้fullstack MVC (Laravel style) → AdonisJS 
 ถา้ตอ้งการ enterprise-grade, scalable, structured, testable → NestJS คือตวัเลือกท่ีดี

ท่ีสดุ 

 
NestJS คืออะไร? 
NestJS คอื Backend Framework บน Node.js ทีส่รา้งขึน้ดว้ย TypeScript (แต่กร็องรบั 
JavaScript) 
ถูกออกแบบมาเพื่อใหก้ารพฒันา Server-side Application มโีครงสรา้งทีช่ดัเจน เป็นระบบ และ 
เหมาะกบังานขนาดใหญ่หรือ Enterprise 
NestJS ไดแ้รงบนัดาลใจมาจาก Angular (ในฝัง่ Frontend) เช่น 

 การใช ้Decorators (@Controller, @Module, @Injectable) 
 การท างานแบบ Dependency Injection (DI) 
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 การแบ่งโครงสรา้งเป็น Modules / Controllers / Services 

 
� NestJS ใช้ท าอะไร? 
NestJS ใชส้ าหรบัสรา้งแอปพลเิคชนัฝัง่เซริฟ์เวอรท์ีต่อ้งการ โครงสร้างและความยืดหยุ่นสงู เช่น 

1. RESTful APIs 
o API แบบดัง้เดมิส าหรบั Mobile / Web Apps 

2. GraphQL APIs 
o รองรบัทัง้ schema-first และ code-first approach 

3. Microservices 
o รองรบั protocol เช่น TCP, gRPC, MQTT, RabbitMQ, Kafka → ท าใหส้รา้งระบบ

แบบ distributed ไดง้า่ย 
4. Real-time Applications 

o ใช ้WebSocket ส าหรบั Chat app, Notification, Live update 
5. Enterprise Applications 

o ระบบใหญ่ทีต่อ้งการ scalability, testability, และ maintainability 

 
� ตวัอย่างโค้ดเปรียบเทียบ (Express vs NestJS) 
� Express (Minimal) 
// app.js 
const express = require('express'); 
const app = express(); 
const port = 3000; 
 
app.get('/hello', (req, res) => { 
  res.send('Hello from Express!'); 
}); 
 
app.listen(port, () => { 
  console.log(`Server running at http://localhost:${port}`); 
}); 
� Express จะเหน็ว่า สัน้และตรงไปตรงมา แต่ถา้โปรเจกตใ์หญ่ขึน้ โคด้จะเริม่ยุง่เหยงิ (ไม่มี
โครงสรา้งบงัคบั) 

 



ศูนยห์นงัสือราคานกัเรียน 

 

NestJS Web Programming: Beginner หนา้ 13 

 

� NestJS (Structured) 
// main.ts (entry point) 
import { NestFactory } from '@nestjs/core'; 
import { AppModule } from './app.module'; 
 
async function bootstrap() { 
  const app = await NestFactory.create(AppModule); 
  await app.listen(3000); 
} 
bootstrap(); 
// app.module.ts (root module) 
import { Module } from '@nestjs/common'; 
import { AppController } from './app.controller'; 
import { AppService } from './app.service'; 
 
@Module({ 
  imports: [], 
  controllers: [AppController],  // จดัการ request 
  providers: [AppService],      // จดัการ business logic 
}) 
export class AppModule {} 
// app.controller.ts (Controller layer) 
import { Controller, Get } from '@nestjs/common'; 
import { AppService } from './app.service'; 
 
@Controller() 
export class AppController { 
  constructor(private readonly appService: AppService) {} 
 
  @Get('hello') 
  getHello(): string { 
    return this.appService.getHello(); 
  } 
} 
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// app.service.ts (Service layer - Business logic) 
import { Injectable } from '@nestjs/common'; 
 
@Injectable() 
export class AppService { 
  getHello(): string { 
    return 'Hello from NestJS!'; 
  } 
} 
� ส่ิงท่ีเหน็จากโค้ด 

 NestJS แบ่งโครงสรา้งเป็น Module / Controller / Service → ชดัเจนว่าหน้าไหนท าอะไร 
 ใช ้Dependency Injection (DI) → AppController ไมต่อ้งสรา้ง AppService เอง NestJS 

จดัการให ้
 โคด้มกีารขยายต่อไดง้่าย → ถา้เพิม่ UsersModule, AuthModule, ProductsModule กจ็ะ

จดัการเป็นระบบมากขึน้ 

 
� สรปุสัน้ ๆ 

 NestJS คือ Backend Framework ท่ีใช้ Node.js + TypeScript 
 ใชท้ า REST API, GraphQL, Microservices, Real-time apps ไดใ้นระดบั Enterprise 
 จดุเด่นคอื มีโครงสร้างชดัเจน, มี Dependency Injection, TypeScript-first, เหมาะกบัทีม

ใหญ่ 

 
แนวคิด OOP, FP และ DI ใน NestJS  

 
1) แนวคิด OOP (Object-Oriented Programming) ใน NestJS 
NestJS ถูกออกแบบโดยใช ้Class และ Decorator เป็นหลกั 
ซึง่เป็นการน าแนวคดิ OOP มาใช ้เช่น Encapsulation, Inheritance, Polymorphism 
� ตวัอยา่ง Service class ทีห่่อหุม้ (Encapsulation) logic การท างาน 
// user.service.ts 
import { Injectable } from '@nestjs/common'; 
 
@Injectable() 
export class UserService { 
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  private users = ['Alice', 'Bob', 'Charlie']; 
 
  // Encapsulation: users ถูกซ่อน (private) และจดัการผ่าน method 
  getAllUsers(): string[] { 
    return this.users; 
  } 
 
  addUser(name: string) { 
    this.users.push(name); 
  } 
} 
� ตวัอยา่ง Inheritance (การสบืทอดคลาส) 
// base.entity.ts 
export class BaseEntity { 
  id: number; 
  createdAt: Date; 
  updatedAt: Date; 
} 
 
// user.entity.ts 
import { BaseEntity } from './base.entity'; 
 
export class UserEntity extends BaseEntity { 
  name: string; 
  email: string; 
} 
➡  จดุแขง็ของ OOP ใน Nest คอืช่วยใหเ้ราแยก Business Logic ออกมาในรปูแบบ class ทีอ่่าน
งา่ยและขยายต่อได ้

 
2) แนวคิด FP (Functional Programming) ใน NestJS 
แมว้่า NestJS จะขบัเคลื่อนดว้ย OOP เป็นหลกั แต่กร็องรบั แนวคิด Functional Programming (FP) 
โดยเฉพาะการใช ้pure functions, immutability, และ higher-order functions 
� ตวัอยา่ง Pure Function ใน Utility 
// math.utils.ts 
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export function sum(a: number, b: number): number { 
  return a + b; // ไมพ่ึง่ state ภายนอก → pure function 
} 
� การใช ้FP กบั RxJS (Reactive Extensions for JavaScript) 
NestJS ม ีintegration กบั Observables (ซึง่เป็นแนวทาง functional) 
// user.controller.ts 
import { Controller, Get } from '@nestjs/common'; 
import { of, map } from 'rxjs'; 
 
@Controller('user') 
export class UserController { 
  @Get() 
  getUserNames() { 
    return of(['Alice', 'Bob', 'Charlie']).pipe( 
      map(users => users.map(u => u.toUpperCase())) // Functional style 
    ); 
  } 
} 
➡  FP ช่วยใหโ้คด้ใน NestJS มคีวาม declarative และเหมาะกบัการจดัการ async streams (เช่น 
HTTP requests, WebSockets) 

 
3) DI (Dependency Injection) ใน NestJS 
หนึ่งใน หวัใจหลกั ของ NestJS คอื Dependency Injection (DI) 
ซึง่ช่วยใหเ้ราสามารถแยกความรบัผดิชอบของแต่ละ class และจดัการ dependency ไดง้า่ยขึน้ 
� ตวัอยา่งการใช ้DI 
// user.module.ts 
import { Module } from '@nestjs/common'; 
import { UserService } from './user.service'; 
import { UserController } from './user.controller'; 
 
@Module({ 
  controllers: [UserController], 
  providers: [UserService], // Register Service as a provider 
}) 
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export class UserModule {} 
// user.controller.ts 
import { Controller, Get, Post, Body } from '@nestjs/common'; 
import { UserService } from './user.service'; 
 
@Controller('users') 
export class UserController { 
  // NestJS จะ Inject UserService มาใหอ้ตัโนมตั ิ
  constructor(private readonly userService: UserService) {} 
 
  @Get() 
  getAllUsers() { 
    return this.userService.getAllUsers(); 
  } 
 
  @Post() 
  addUser(@Body('name') name: string) { 
    this.userService.addUser(name); 
    return { message: 'User added!' }; 
  } 
} 
➡  จดุเด่นของ DI ใน NestJS คอื 

 ไมต่อ้ง new class เอง → Nest จดัการ lifecycle ให ้
 สามารถ mock service ไดง้่ายเวลา เขียน unit test 
 ช่วยใหโ้คด้ หลวม (loosely coupled) และเปลีย่น implementation ไดง้า่ย 

 
� สรปุ 

 OOP → ใช ้class + decorator → โคด้มโีครงสรา้งและจดัการง่าย 
 FP → ใช ้pure functions + RxJS → เหมาะกบั async และ reactive programming 
 DI → Nest จดัการ dependency lifecycle ให ้→ ลดความซบัซอ้นและเพิม่ความ testable 

� NestJS ไมไ่ดบ้งัคบัใหใ้ช ้OOP หรอื FP เพยีงอยา่งเดยีว แต่ บรูณาการทัง้สองแนวคิด แลว้เสรมิ
ดว้ย DI เพื่อใหไ้ด ้framework ทีท่ ัง้ยดืหยุน่และ maintainable 
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โครงสร้างโฟลเดอรม์าตรฐานของโปรเจกต ์NestJS 

 
� โครงสร้างโฟลเดอรม์าตรฐานใน NestJS 
เมือ่เราสรา้งโปรเจกตด์ว้ย Nest CLI (nest new project-name) 
จะไดโ้ครงสรา้งเริม่ตน้ประมาณนี้ � 
my-nest-project/ 
│ 
├── src/                        # Source code ทัง้หมดอยูใ่นนี้ 
│   ├── app.controller.ts        # Controller หลกั (ตวัอยา่ง) 
│   ├── app.controller.spec.ts   # Unit test ของ Controller 
│   ├── app.module.ts            # Root Module (entry point ของ app) 
│   ├── app.service.ts           # Service หลกั (ตวัอยา่ง) 
│   └── main.ts                  # Entry point ของโปรแกรม (bootstrap) 
│ 
├── test/                        # Integration/E2E tests 
│   └── app.e2e-spec.ts 
│ 
├── node_modules/                # Dependencies 
├── package.json                 # รายการ dependencies และ scripts 
├── tsconfig.json                # TypeScript config 
└── nest-cli.json                # Config ของ Nest CLI 

 
1) ไฟลห์ลกั 

 main.ts → จดุเริม่ตน้ของแอป ใช ้NestFactory bootstrap application 
 import { NestFactory } from '@nestjs/core'; 
 import { AppModule } from './app.module'; 
  
 async function bootstrap() { 
   const app = await NestFactory.create(AppModule); 
   await app.listen(3000); 
   console.log(`� Application is running on: http://localhost:3000`); 
 } 
 bootstrap(); 
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 app.module.ts → Root module ของโปรเจกต ์(บอกว่าใช ้controller/service ไหนบา้ง) 
 import { Module } from '@nestjs/common'; 
 import { AppController } from './app.controller'; 
 import { AppService } from './app.service'; 
  
 @Module({ 
   imports: [],              // import module อื่นๆ 
   controllers: [AppController],  
   providers: [AppService],  // register service 
 }) 
 export class AppModule {} 
 app.controller.ts → จดัการ HTTP request/response 
 import { Controller, Get } from '@nestjs/common'; 
 import { AppService } from './app.service'; 
  
 @Controller() 
 export class AppController { 
   constructor(private readonly appService: AppService) {} 
  
   @Get() 
   getHello(): string { 
     return this.appService.getHello(); 
   } 
 } 
 app.service.ts → Business logic 
 import { Injectable } from '@nestjs/common'; 
  
 @Injectable() 
 export class AppService { 
   getHello(): string { 
     return 'Hello NestJS!'; 
   } 
 } 
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2) เม่ือมี Feature/Module เพ่ิมขึ้น 
NestJS แนะน าใหจ้ดัโฟลเดอรแ์ยกตาม Domain / Feature-based structure 
เช่น ถา้ม ีUsers module 
src/ 
├── users/ 
│   ├── users.controller.ts 
│   ├── users.service.ts 
│   ├── users.module.ts 
│   └── dto/ 
│       └── create-user.dto.ts 

 users.module.ts → module ส าหรบัจดัการ Users 
 users.controller.ts → API endpoint เช่น GET /users, POST /users 
 users.service.ts → logic การท างาน เช่น จดัการ user list 
 dto/ → Data Transfer Object (แยกโครงสรา้งขอ้มลู request/response) 

ตวัอยา่ง users.module.ts 
import { Module } from '@nestjs/common'; 
import { UsersController } from './users.controller'; 
import { UsersService } from './users.service'; 
 
@Module({ 
  controllers: [UsersController], 
  providers: [UsersService], 
}) 
export class UsersModule {} 

 
3) โครงสร้างโปรเจกต์ในระดบักลางถึงใหญ่ 
เมือ่โปรเจกตใ์หญ่ขึน้ เราจะเจอโฟลเดอรป์ระมาณนี้ 
src/ 
├── common/              # utilities, filters, interceptors, guards 
├── config/              # configuration (database, env) 
├── database/            # entities, repositories 
├── users/               # feature module: users 
├── auth/                # feature module: authentication 
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├── products/            # feature module: products 
├── app.module.ts        # root module 
└── main.ts              # entry point 
� หลกัการ NestJS → Everything is a Module 
ทุกฟีเจอรค์วรแยกออกเป็น Module เพื่อให ้maintain งา่ย, test งา่ย, และ reuse ได ้

 
� สรปุ 

 ระดบัเลก็ → Nest จะม ีapp.controller.ts, app.service.ts, app.module.ts, main.ts 
 ระดบักลาง/ใหญ่ → แยกโฟลเดอรต์าม feature/domain (เช่น users, auth, products) 
 ข้อดีของโครงสร้าง Nest 

o อ่านงา่ย → แยกตามฟีเจอรช์ดัเจน 
o ขยายได ้→ เพิม่ module ไดเ้รือ่ยๆ 
o รองรบั OOP + DI โดยธรรมชาต ิ

 
การติดตัง้ Nest CLI และการสร้างโปรเจกตใ์หม่  

 
� การติดตัง้ Nest CLI และสร้างโปรเจกต์ใหม่ 
1) ติดตัง้ Node.js 

 ก่อนอื่นตอ้งม ีNode.js และ npm (Node Package Manager) อยูใ่นเครือ่ง 
 แนะน า Node.js เวอรช์นั LTS (Long Term Support) 

ตรวจสอบเวอรช์นัดว้ยค าสัง่: 
node -v 
npm -v 

 
2) ติดตัง้ Nest CLI 
NestJS ม ีCommand Line Interface (CLI) ทีช่่วยใหก้ารสรา้งโปรเจกตส์ะดวกขึน้ 
ตดิตัง้แบบ global: 
npm install -g @nestjs/cli 
ตรวจสอบว่า CLI ใชง้านได:้ 
nest --version 

 
3) สร้างโปรเจกตใ์หม่ 
ใชค้ าสัง่: 
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nest new my-nest-app 
 my-nest-app คอืชื่อโปรเจกต ์(ตัง้ชื่ออะไรกไ็ด)้ 
 CLI จะถามว่าใหใ้ช ้แพก็เกจจดัการ dependency อะไร → เลอืกได ้เช่น npm หรอื yarn 

เมือ่สรา้งเสรจ็จะไดโ้ครงสรา้งโปรเจกตแ์บบน้ี: 
my-nest-app/ 
│ 
├── src/ 
│   ├── app.controller.ts 
│   ├── app.module.ts 
│   ├── app.service.ts 
│   └── main.ts 
├── package.json 
├── tsconfig.json 
└── nest-cli.json 

 
4) รนัโปรเจกต์ 
เขา้ไปทีโ่ฟลเดอรโ์ปรเจกต์ แลว้รนั: 
cd my-nest-app 
npm run start 
ถา้ตอ้งการใหร้โีหลดอตัโนมตัเิมือ่แกโ้คด้: 
npm run start:dev 
� เมือ่รนัส าเรจ็ จะเหน็ขอ้ความ: 
� Application is running on: http://localhost:3000 
ลองเขา้เวบ็เบราวเ์ซอร ์→ ไปที ่http://localhost:3000 
จะไดข้อ้ความตอบกลบั: 
Hello World! 

 
5) ตวัอย่างโค้ดเร่ิมต้น (default) 
โคด้ที ่NestJS สรา้งมาใหจ้ะประมาณนี้ 
main.ts 
import { NestFactory } from '@nestjs/core'; 
import { AppModule } from './app.module'; 
 
async function bootstrap() { 
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  const app = await NestFactory.create(AppModule); 
  await app.listen(3000); 
  console.log('Application is running on: http://localhost:3000'); 
} 
bootstrap(); 
app.module.ts 
import { Module } from '@nestjs/common'; 
import { AppController } from './app.controller'; 
import { AppService } from './app.service'; 
 
@Module({ 
  imports: [], 
  controllers: [AppController], 
  providers: [AppService], 
}) 
export class AppModule {} 
app.controller.ts 
import { Controller, Get } from '@nestjs/common'; 
import { AppService } from './app.service'; 
 
@Controller() 
export class AppController { 
  constructor(private readonly appService: AppService) {} 
 
  @Get() 
  getHello(): string { 
    return this.appService.getHello(); 
  } 
} 
app.service.ts 
import { Injectable } from '@nestjs/common'; 
 
@Injectable() 
export class AppService { 
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  getHello(): string { 
    return 'Hello World!'; 
  } 
} 

 
� เพยีงเท่านี้กไ็ด ้NestJS Project แรก พรอ้มรนัแลว้ 

 
การติดตัง้และทดสอบ NestJS บน IDE/Editor 
เราจะพดูถงึ 3 Tools ดงันี้: 

1. Visual Studio Code (VS Code) 
2. WebStorm (JetBrains) 
3. IntelliJ IDEA / Node.js plugin 

 
  ⃣ Visual Studio Code (VS Code) 
ขัน้ตอนติดตัง้ 

1. ดาวน์โหลดและตดิตัง้ VS Code 
2. ตดิตัง้ Node.js LTS และ npm 
3. เปิด VS Code → เปิด Terminal (Ctrl+`) 
4. ตดิตัง้ Nest CLI global: 
5. npm install -g @nestjs/cli 
6. สรา้งโปรเจกตใ์หม:่ 
7. nest new my-nest-app 
8. เลอืก npm หรอื yarn ตาม preference 

การรนัโปรเจกต์ 
 เปิด terminal ใน VS Code → รนั: 
 npm run start:dev 
 เปิดเวบ็เบราวเ์ซอร ์→ http://localhost:3000 
 จะเหน็ขอ้ความ: 
 Hello World! 

Extension แนะน า 
 ESLint → ตรวจ syntax/format 
 Prettier → จดั format code 
 NestJS Snippets → ช่วย generate code ของ NestJS 

https://code.visualstudio.com/
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  ⃣ WebStorm (JetBrains) 
ขัน้ตอนติดตัง้ 

1. ดาวน์โหลด WebStorm 
2. เปิด WebStorm → New Project → Node.js Express (เลอืก TypeScript) 
3. เปิด Terminal ภายใน WebStorm 
4. ตดิตัง้ Nest CLI: 
5. npm install -g @nestjs/cli 
6. สรา้งโปรเจกต:์ 
7. nest new my-nest-app 
8. WebStorm จะ recognize project เป็น Node/TypeScript project อตัโนมตั ิ

การรนัโปรเจกต์ 
 ไปที ่Terminal → รนั: 
 npm run start:dev 
 หรอืสรา้ง Run Configuration → เลอืก npm start เพื่อรนัจาก IDE 

Features ท่ีช่วย 
 Auto-import decorators (@Controller, @Injectable) 
 Code navigation ระหว่าง Module/Service/Controller 
 Integrated terminal และ debugger 

 
  ⃣ IntelliJ IDEA (Community หรือ Ultimate) + Node.js plugin 
ขัน้ตอนติดตัง้ 

1. ดาวน์โหลด IntelliJ IDEA 
2. ตดิตัง้ Node.js plugin (Settings → Plugins → Marketplace → Node.js) 
3. เปิด IntelliJ → New Project → Node.js + TypeScript 
4. เปิด Terminal → ตดิตัง้ Nest CLI: 
5. npm install -g @nestjs/cli 
6. สรา้งโปรเจกต ์Nest ใหม:่ 
7. nest new my-nest-app 

การรนัโปรเจกต์ 
 เปิด Terminal → npm run start:dev 
 หรอืสรา้ง Run/Debug Configuration เลอืก Node.js script → main.ts 

Features ท่ีช่วย 

https://www.jetbrains.com/webstorm/
https://www.jetbrains.com/idea/
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 Advanced debugging (breakpoints, step-over, variable watch) 
 TypeScript auto-completion 
 Project structure management ส าหรบัหลาย Module 

 
� Tips ทัว่ไปส าหรบัทุก IDE 

1. ใช ้start:dev ส าหรบั hot-reload → พฒันาเรว็ 
2. ใช ้Decorators + DI → IDE จะช่วย auto-import 
3. ตดิตัง้ ESLint + Prettier → รกัษามาตรฐานโคด้ 
4. สรา้ง Launch/Debug configuration → รนัและ debug ใน IDE ไดโ้ดยตรง 

 
สรปุ: 

IDE เหมาะกบั จดุเด่น 

VS Code ฟร,ี เบา, plugin เยอะ Terminal + Snippets + Hot reload 

WebStorm Professional, ทมีใหญ่ Code navigation, debugger, auto-import 

IntelliJ IDEA ทมีทีใ่ช ้JetBrains ecosystem Advanced debug, multi-language support 

 
การติดตัง้ NestJS และทดสอบโปรเจกตบ์น NetBeans IDE 
การติดตัง้ NestJS และทดสอบโปรเจกตบ์น NetBeans IDE อยา่งละเอยีดทลีะขัน้ตอน 
หมายเหตุ: NetBeans เป็น IDE ทีเ่น้น Java เป็นหลกั แต่กร็องรบั Node.js / JavaScript / 
TypeScript ผ่าน plugin ทีต่ดิตัง้เพิม่ได ้
ดงันัน้การพฒันา NestJS บน NetBeans ยงัไมเ่ป็นทีน่ิยมเท่า VS Code หรอื WebStorm แต่สามารถ
ท างานได ้

 
� การติดตัง้และรนั NestJS บน NetBeans IDE 

  ⃣ เตรียมเครื่องมือพ้ืนฐาน 
1. ตดิตัง้ Node.js เวอรช์นั LTS 

o ดาวน์โหลดจาก https://nodejs.org 
o ตรวจสอบเวอรช์นั: 
o node -v 
o npm -v 

2. ตดิตัง้ Nest CLI แบบ global: 
3. npm install -g @nestjs/cli 

https://nodejs.org/
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4. ตดิตัง้ TypeScript (ถา้โปรเจกต ์Nest ยงัไมไ่ดต้ดิตัง้) 
5. npm install -g typescript 

 
  ⃣ ติดตัง้ NetBeans และ Plugin Node.js 

1. ดาวน์โหลด Apache NetBeans (เวอรช์นัล่าสุด แนะน า 17+) 
2. เปิด NetBeans → ไปที ่

Tools → Plugins → Available Plugins → คน้หา "Node.js" → ตดิตัง้ 
3. หลงัตดิตัง้ ให ้restart IDE 

� หลงัจากตดิตัง้ plugin Node.js แลว้ NetBeans จะสามารถ: 
 สรา้ง Node.js project 
 รนั / debug script JS/TS 
 รองรบั npm commands 

 
  ⃣ สร้างโปรเจกต ์NestJS ใหม่ใน NetBeans 
วิธีท่ี 1: ใช้ Nest CLI ผ่าน Terminal 

1. เปิด Terminal ใน NetBeans (Tools → Terminal) 
2. รนัค าสัง่: 
3. nest new my-nest-app 
4. เลอืก npm หรอื yarn 
5. Nest CLI จะสรา้งโปรเจกต์พรอ้มโครงสรา้งมาตรฐาน: 

my-nest-app/ 
├── src/ 
│   ├── main.ts 
│   ├── app.module.ts 
│   ├── app.controller.ts 
│   └── app.service.ts 
├── package.json 
├── tsconfig.json 
└── nest-cli.json 
วิธีท่ี 2: สร้าง Node.js Project ใน NetBeans แล้วติดตัง้ NestJS 

1. File → New Project → Node.js Application 
2. ก าหนด Project Folder 
3. เปิด Terminal → รนั: 

https://netbeans.apache.org/
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4. npm install @nestjs/core @nestjs/common rxjs reflect-metadata 
5. npm install --save-dev @nestjs/cli typescript ts-node @types/node 
6. npx nest new . 

 
  ⃣ การรนัโปรเจกต์ NestJS ใน NetBeans 

1. เปิด Terminal ใน NetBeans → ไปทีโ่ฟลเดอรโ์ปรเจกต์ 
2. รนัค าสัง่: 
3. npm run start:dev 

o ใช ้start:dev เพื่อ hot reload เวลาแกไ้ขโคด้ 
4. เปิดเบราวเ์ซอร ์→ เขา้ http://localhost:3000 

จะเหน็ขอ้ความ: 
5. Hello World! 

 
  ⃣ การตัง้ค่า Debug ใน NetBeans 

1. Run → Set Project Configuration → Customize → Node.js 
2. ก าหนด Main File เป็น src/main.ts 
3. กด Debug Project → NetBeans จะเปิด debugger 

o สามารถตัง้ breakpoints ใน Controller / Service 
o Inspect variable / call stack ได ้

 
  ⃣ การติดตัง้ Extensions / Tools เสริม 

 ESLint → ตรวจ syntax / linting 
 npm install --save-dev eslint @typescript-eslint/parser @typescript-eslint/eslint-plugin 
 Prettier → จดั format code 
 npm install --save-dev prettier 
 NestJS Snippets → สามารถใชผ้่าน VS Code/Editor แยกเพื่อ copy code (NetBeans ไม่

ม ีplugin เฉพาะ NestJS) 

 
� ข้อจ ากดับน NetBeans 

1. Plugin Node.js ยงัไมค่รบ feature เท่า VS Code หรอื WebStorm 
2. Auto-import decorators (@Controller, @Injectable) ยงัไมส่ะดวก 
3. Hot reload ใชไ้ดผ้่าน npm run start:dev แต่ไมม่ ีintegration ใน GUI IDE 
4. เหมาะส าหรบั ผูท่ี้ช านาญ Node.js + NetBeans อยู่แล้ว 



ศูนยห์นงัสือราคานกัเรียน 

 

NestJS Web Programming: Beginner หนา้ 29 

 

 
� สรปุขัน้ตอน 

1. ตดิตัง้ Node.js + npm + TypeScript 
2. ตดิตัง้ Nest CLI 
3. ตดิตัง้ NetBeans + Node.js plugin 
4. สรา้งโปรเจกต ์NestJS (CLI หรอื Node.js project) 
5. รนัโปรเจกตผ์่าน Terminal (npm run start:dev) 
6. ตัง้ Debug Configuration → Debug controller/service ได ้

 
 

สรปุ 
บทที่ 1 จะปูพื้นฐานเกี่ยวกบั NestJS โดยอธบิายว่า NestJS คอืเฟรมเวริก์บน Node.js ที่ใช ้
TypeScript เพื่อสรา้งแอปพลเิคชนัฝัง่เซริฟ์เวอรไ์ดอ้ย่างมปีระสทิธภิาพ รองรบังานระดบัองคก์ร พรอ้ม
ผสานแนวคดิ OOP, FP และ Dependency Injection (DI) เพื่อท าใหโ้คด้มคีวามเป็นระบบและดูแล
รกัษาง่าย นอกจากนี้ยงัแนะน า โครงสร้างโฟลเดอรม์าตรฐานของโปรเจกต์ ที่แยก Controller, 
Service และ Module ออกจากกนัอย่างชดัเจน และแนะน าการใช้ Nest CLI ในการตดิตัง้และสรา้งโปร
เจกตใ์หม ่เพื่อเตรยีมความพรอ้มส าหรบัการพฒันาในบทถดัไป. 
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บทท่ี 2 
Controllers และ Routing เบือ้งต้น 
(Basic of Controllers and Routing) 

 
เน้ือหา  

 Controllers และ Routing เบือ้งตน้ 
 เจาะลกึเรือ่ง Controllers และ Routing เบือ้งตน้ใน NestJS แบบ เชงิลกึ 
 การสรา้ง Controller ดว้ย CLI 
 การสรา้ง Route ดว้ย @Get และ @Post 
 การรบัค่าจาก Route Params, Query, และ Body 
 DTO เบือ้งตน้ใน NestJS 
 ตวัอยา่งบรูณาการ 
 Ultimate Integrated Project  

 
 
บทน าบทท่ี 2: Controllers และ Routing เบือ้งต้น 
ในการพัฒนาแอปพลิเคชันฝัง่เซิร์ฟเวอร์ หน้าที่ส าคัญที่สุดประการหนึ่งคือการ  จดัการค าขอ 
(Request) และส่งค าตอบ (Response) กลบัไปยงัผูใ้ชง้าน NestJS ออกแบบใหก้ระบวนการนี้เป็น
เรื่องง่ายผ่าน Controller และระบบ Routing ซึ่งเป็นหวัใจหลกัในการสื่อสารระหว่าง Client และ 
Server หากในบทแรกเราไดท้ าความเขา้ใจกบัโครงสรา้งพืน้ฐานของโปรเจกต์แลว้ บทนี้จะพาไปสู่การ
สรา้ง Controller และเสน้ทาง (Route) แรกของคุณใน NestJS 

NestJS มเีครื่องมอื CLI ทีช่่วยใหน้ักพฒันาสามารถสรา้ง Controller ไดอ้ย่างสะดวก โดยเพยีง
ใช้ค าสัง่ไม่กี่บรรทดัก็จะไดไ้ฟล์ Controller พรอ้มโครงร่างเบื้องต้น ซึง่สามารถปรบัแต่งใหร้องรบัการ
ท างานทีซ่บัซอ้นขึน้ได ้การใช ้CLI ไมเ่พยีงช่วยลดเวลาในการตัง้ค่า แต่ยงัคงมาตรฐานโครงสรา้งโคด้ให้
เป็นรปูแบบเดยีวกนัตลอดทัง้โปรเจกต์ 

ในส่วนของการสรา้งเสน้ทาง (Routing) NestJS ใช ้ Decorator เช่น @Get() และ @Post() 
เพื่อก าหนดว่าฟังก์ชนัภายใน Controller จะตอบสนองต่อค าขอแบบใด @Get() จะท างานเมื่อมกีารส่ง
ค าขอแบบ HTTP GET เขา้มา ส่วน @Post() จะใชส้ าหรบัค าขอแบบ HTTP POST การท างานเช่นนี้
ช่วยใหน้กัพฒันาก าหนดพฤตกิรรมของ API แต่ละเสน้ทางไดอ้ยา่งชดัเจนและสัน้กระชบั 

นอกจากนี้ Routing ใน NestJS ยงัรองรบัการ รบัค่าเพ่ิมเติมจากผู้ใช้ ไม่ว่าจะเป็น Route 
Parameters, Query Parameters หรอื Request Body เช่น การดงึค่า id จาก URL, การอ่านค่า
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คน้หาจาก query string หรอืการรบัขอ้มลูแบบ JSON จาก body การรองรบัรปูแบบทีห่ลากหลายนี้ท า
ให ้API ทีส่รา้งขึน้มคีวามยดืหยุน่และสามารถตอบสนองต่อความตอ้งการทีซ่บัซอ้นได้ 

เพื่อให้โค้ดมคีวามเป็นระบบและตรวจสอบขอ้มูลไดง้่าย NestJS แนะน าให้ใช้ DTO (Data 
Transfer Object) ในการจดัการขอ้มลูทีส่่งเขา้มาจาก Client DTO คอืคลาสทีท่ าหน้าทีก่ าหนดรปูแบบ
ขอ้มูลที่คาดหวงั เช่น ฟิลด์ที่ต้องมหีรอืประเภทของขอ้มูล วธินีี้ช่วยให้สามารถควบคุมและตรวจสอบ
ความถูกตอ้งของขอ้มลูไดต้ัง้แต่ระดบัโครงสรา้งโคด้ ท าใหร้ะบบมคีวามปลอดภยัและน่าเชื่อถอืมากขึน้ 

ในเชงิปฏบิตั ิบทนี้จะน าเสนอวธิกีารสรา้ง Controller เบือ้งต้นดว้ย CLI จากนัน้จะอธบิายการ
เพิม่เสน้ทางดว้ย @Get และ @Post รวมถงึการใชง้านตวัอย่างการรบัค่าจาก route params, query 
และ body อยา่งเป็นขัน้ตอน สุดทา้ยจะอธบิายวธิสีรา้ง DTO อยา่งงา่ยเพื่อใชต้รวจสอบขอ้มลูทีร่บัเขา้มา
จากผูใ้ชง้าน 

กล่าวโดยสรุป บทนี้จะปพูืน้ฐานการท างานของ Controller และ Routing ใน NestJS อย่าง
ครบถ้วน เพื่อให้คุณสามารถสรา้ง API ทีร่บัค าขอจาก Client ไดจ้รงิ โดยมทีัง้โครงสรา้งที่เป็นระบบ 
ความปลอดภยั และความยดืหยุ่น ความรูเ้หล่านี้จะเป็นเครื่องมอืส าคญัในการพฒันาฟีเจอร์ที่ซบัซ้อน
ยิง่ขึน้ในบทต่อไป 

 
Controllers และ Routing เบือ้งต้น 

 สรา้ง Controller ดว้ย CLI 
 การสรา้ง route ดว้ย @Get, @Post 
 การรบัค่าจาก route params, query, body 
 การใช ้DTO เบือ้งตน้ 

 
� บทท่ี 2: Controllers และ Routing เบือ้งต้น 
ใน NestJS Controller คอืส่วนที ่รบั HTTP request และส่ง response เป็นหลกั 
Controller จะเป็นตวักลางระหว่าง client กบั business logic (Service) 

 
  ⃣ สร้าง Controller ด้วย CLI 
NestJS CLI ช่วยสรา้ง controller แบบอตัโนมตั ิ
nest generate controller users 
# หรอืสัน้ 
nest g co users 

 users → ชื่อ controller 
 CLI จะสรา้งไฟลใ์นโฟลเดอร ์src/users/ 
 สรา้งตวัอยา่งไฟล:์ 
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 src/users/users.controller.ts 
 src/users/users.controller.spec.ts 

ตวัอย่าง users.controller.ts เร่ิมต้น 
import { Controller, Get } from '@nestjs/common'; 
 
@Controller('users') // route prefix 
export class UsersController { 
  @Get() 
  findAll(): string { 
    return 'This action returns all users'; 
  } 
} 

 @Controller('users') → prefix ของ route /users 
 @Get() → mapping HTTP GET method 

 
  ⃣ การสร้าง Route ด้วย @Get และ @Post 
NestJS รองรบั decorator ส าหรบั HTTP methods เช่น: 

HTTP Method Decorator 

GET @Get() 

POST @Post() 

PUT @Put() 

DELETE @Delete() 

PATCH @Patch() 

ตวัอย่าง controller แบบ GET และ POST 
import { Controller, Get, Post, Body } from '@nestjs/common'; 
 
@Controller('users') 
export class UsersController { 
  private users = ['Alice', 'Bob']; 
 
  @Get() 
  getAllUsers(): string[] { 
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    return this.users; 
  } 
 
  @Post() 
  addUser(@Body('name') name: string): string { 
    this.users.push(name); 
    return `User ${name} added successfully`; 
  } 
} 

 @Body('name') → ดงึค่า name จาก request body 

 
  ⃣ การรบัค่าจาก Route Params, Query, Body 
a) Route Params 
import { Controller, Get, Param } from '@nestjs/common'; 
 
@Controller('users') 
export class UsersController { 
  private users = ['Alice', 'Bob']; 
 
  @Get(':id') 
  getUser(@Param('id') id: number): string { 
    return this.users[id]; 
  } 
} 

 URL: /users/1 → id = 1 
 ใช ้@Param('paramName') เพื่อดงึค่า 

b) Query Params 
import { Controller, Get, Query } from '@nestjs/common'; 
 
@Controller('users') 
export class UsersController { 
  @Get('search') 
  searchUser(@Query('name') name: string): string { 
    return `Search result for user: ${name}`; 
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  } 
} 

 URL: /users/search?name=Alice → name = Alice 
 ใช ้@Query('queryParam') 

c) Request Body 
import { Controller, Post, Body } from '@nestjs/common'; 
 
@Controller('users') 
export class UsersController { 
  @Post() 
  createUser(@Body() body: { name: string; age: number }): string { 
    return `User ${body.name} aged ${body.age} added`; 
  } 
} 

 Body JSON: 
{ 
  "name": "Charlie", 
  "age": 25 
} 

 
  ⃣ การใช้ DTO (Data Transfer Object) เบือ้งต้น 
DTO คอื object ท่ีก าหนดรปูแบบข้อมลูท่ีส่งเข้าหรือออก 
ช่วย validate, type-safe และอ่านโคด้ง่ายขึน้ 
ตวัอย่าง DTO 
// src/users/dto/create-user.dto.ts 
export class CreateUserDto { 
  name: string; 
  age: number; 
} 
ใช้ DTO ใน Controller 
import { Controller, Post, Body } from '@nestjs/common'; 
import { CreateUserDto } from './dto/create-user.dto'; 
 
@Controller('users') 
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export class UsersController { 
  @Post() 
  createUser(@Body() createUserDto: CreateUserDto): string { 
    return `User ${createUserDto.name} aged ${createUserDto.age} added`; 
  } 
} 
✅ ขอ้ดขีอง DTO 

 ชดัเจนว่าขอ้มลู body ตอ้งมอีะไรบา้ง 
 สามารถต่อยอดกบั class-validator เพื่อ validate อตัโนมตั ิ

import { IsString, IsInt } from 'class-validator'; 
 
export class CreateUserDto { 
  @IsString() 
  name: string; 
 
  @IsInt() 
  age: number; 
} 

 
� สรปุบทน้ี 

1. Controller → รบั request และ return response 
2. สรา้ง Controller ดว้ย CLI: nest g co users 
3. Route → ใช ้decorator เช่น @Get(), @Post(), @Put(), @Delete() 
4. รบัค่า Route Params → @Param() 
5. รบัค่า Query Params → @Query() 
6. รบัค่า Body → @Body() 
7. ใช ้DTO → ก าหนด structure ขอ้มลู, เพิม่ type-safety, ต่อยอด validation 

 
เจาะลึกเรื่อง Controllers และ Routing เบือ้งต้นใน NestJS แบบ เชิงลึก

 
� 1) ความเข้าใจเชิงลึกของ Controller 

 Controller คอื class ที ่รบัผิดชอบเฉพาะเร่ืองการจดัการ HTTP request และ response 
 NestJS แนะน าให ้Controller เป็น thin layer 
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o ไม่ควรมี business logic หรือ database query 
o แค่ call Service แลว้ return response 

 Decorator @Controller(): 
o เป็น metadata ส าหรบั NestJS เพื่อบอกว่า class นี้เป็น Controller 
o สามารถใส่ prefix ของ route เช่น @Controller('users') → routes ทัง้หมดจะเริม่

ดว้ย /users 
การท างานภายใน NestJS 

1. เมือ่ HTTP request เขา้มา NestJS Router Explorer จะหา Controller ที ่match กบั route 
และ HTTP method 

2. NestJS inject dependency ให ้Controller อตัโนมตั ิ(DI) 
3. Controller ส่ง response กลบั client ผ่าน return value หรือ Observable / Promise 

 
� 2) Routing ด้วย HTTP method decorator 
NestJS ใช ้decorator แทนการเขยีน routing แบบดัง้เดมิ เช่น Express 

Decorator HTTP Method Usage 

@Get() GET ดงึขอ้มลู 

@Post() POST สรา้ง resource 

@Put() PUT แกไ้ข resource 

@Patch() PATCH แกไ้ขบางส่วน 

@Delete() DELETE ลบ resource 

เชิงลึก: decorator ไมใ่ช่แค่ก าหนด route แต่ เพ่ิม metadata ให้ NestJS สร้าง router map อตัโนมตั ิ
@Controller('users') 
export class UsersController { 
  @Get(':id') 
  findOne(@Param('id') id: string) { 
    // NestJS แปลง route param เป็น argument ให ้
    return `User ID: ${id}`; 
  } 
 
  @Post() 
  create(@Body() body: any) { 
    // body ถูก parse จาก JSON ผ่าน built-in body parser 
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